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1. Membership Committee Overview
Historical Background: The Membership Committee was initially called the Registration Committee and
was one of the four original committees of the Academy in 1991. In the first year, there were 108
members. Our highest membership was in 2018/19, with 435 members. In 2020/21, there were 337
members plus two life members. The position of Volunteer Co-Ordinator was added in 2007. In 2009,
the Committee introduced randomized selection for over-subscribed workshops. Originally, the
Committee used Excel to monitor members on file. This was switched to Filemaker, a relational
database program in 1995 and in 2008 Datatrium was introduced to host the Filemaker database so that
more people could access it for data input. In 2015, registration became fully automated, including
payment of fees.
Composition: The Membership Committee consists of a Chair, Assistant Chair, Manager of the
Academy's Database, Volunteer Coordinator, and other Academy members chosen by the Chair.
Manuals: There are three manuals related to membership
1. Membership Committee Handbook (THIS ONE with detailed Procedures). To be provided to
Membership Committee members by the chair
2. Members Handbook: a briefer overview of all committees
3. Membership Committee User Guide: a brief overview of the roles of the Membership
Committee. Intended as an introduction for members new to the committee. This also contains
a schedule of responsibilities over the year for the Membership Committee.
Terms of Reference: The role of the Membership Committee consists of seven key areas:
•

Registration Services:
o Informing existing members and those on the Potentials list (e.g. Have attended Spring
Talks) about the registration process
o The new Calendar is made available online in April and online registration opens at the
same time. An email address is required for everyone who registers.
o All registration data is entered into the database as it is received until the date for
randomization. On that date, applications for oversubscribed workshops are
randomized to determine admission to the workshop and to create waitlists. After
randomization, registrations are processed and added to the waitlists on a first-come,
first-served basis. Three places in each workshop are held for new members until July
1st, after which time they are assigned to those waitlisted in priority order. The
following are the activities performed by the Membership Committee to enable
registration in the Academy.
•
Processing registration forms and fees (database entry April-January)
•
Running the randomization process for over-subscribed workshops,
with Board members and affected facilitators (plus members) invited to
attend (late April / early May)
•
Contacting all members who are waitlisted (early May)
•
Confirming status in workshops and waitlists by email
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•
•
•

•

Tracking waitlists for over-subscribed workshops and assisting members
in selecting alternatives (June or until the end of registration in January)
Advising Facilitators of their workshop enrollment and confirming
maximum numbers they will accept in their workshop (April-September)
Preparing class lists and attendance sheets for workshops (preliminary,
in June; final in September). This includes preparing files of attendance
sheets and folders in the classrooms.

New Member Orientation
o

o

Once registration is underway, our Volunteer Coordinator contacts all new members to
welcome them to the Academy and asks them to complete an Optional Data Form
(shown in Section 16)
Each September, the Membership Committee works with the Special Events and Talks
Committees to welcome new members to the Academy to a separate event for new
members (New Member Orientation).

o

•

•

The Committee also receives calls and emails from potential new members throughout
the year, and facilitates their registration by directing them to the website if they wish
to register or adding them to our potential members mailing list if they do not.
o The Committee attends Spring Talks and adds non-members to our potential members
mailing list.
Monitoring Membership Numbers:
o The Committee provides registration data to assist the Board make decisions regarding
recruitment and other needs.
o Members who have not renewed their membership are encouraged to become
Associate Members. Follow-up surveys on lapsed members are conducted periodically.
Volunteer Coordination
o
o
o

o

•

•

The Volunteer Coordinator works to let members know what opportunities there are for
them to help run the Academy.
The Volunteer Coordinator attends Membership meetings.
The Volunteer Coordinator uses the database to enter Optional Data and identify
people who might be interested in helping with specific tasks and recruits members to
sit on committees and to carry out the various tasks necessary to run an organization
with no paid staff.
The Volunteer Coordinator also works with the Board's Nominating Committee to help
with nominations to the Board and in recruiting new Vice Chairs for Committees.

Special Events Registration
o The Membership Committee records the attendees of special events (Holiday Lunch,
Spring Lunch, Facilitator Forum, and Volunteer Lunch) in the database and creates
attendees lists, labels, badges as requested
Membership Data Management
o Keeping members’ data current – i.e., phone changes, email changes etc.
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o Adding potential members who have provided email addresses throughout the year
o Providing historical data on past workshops and academy volunteers
• Database Management
o One of the ongoing tasks of the Membership Committee is to manage the Academy's
database overseen by the Manager of the Database. Some tasks included are:
•
Adding new functions as required by the Board, Membership
Committee and other committees
•
Creating a new database for each new term year
•
Training new committee members to work with the database
•
Answering questions of committee members about the working of the
database
•
Resolving database issues
Reporting: The Membership Committee reports to the Board on membership data and procedures.

2. Membership Software
Filemaker Pro can be used either on the Web or as a program downloaded onto a computer. Normally,
the downloaded program would be on a home computer for regular use. However, the web edition can
be used from an internet connection just about anywhere – even on an iPad or an iPod Touch. Changes
can thus be made easily and “on the fly” with the Web edition. To access layouts other than the main
Membership Record on the Web version, click on the file folder icon at the top left of the screen and
select Layout for a choice of available layouts.
A modification has been made to the Membership Database to ask for verification of changes before
they are saved. This will prevent mistakes from being saved.

3. Using Find Function
The FIND process is very useful for locating information about membership and creating custom
reports. As described below, there are a number of options.
TO FIND
If the “Exit Preview” button is showing, press it before starting the Find.
Click on the Find box and wait until all fields go blank with the search magnifier in the fields
Fields with written information:
o Type a name to find a person (often the first few letters of First and Last Names will
suffice)
o OR specify the criterion e.g. from the drop-down menus in Status click on (F) to find the
Facilitators.
o OR Specify a date e.g. members registered on 4/8/2015 in the Date Registered field
o

To find content in a field enter * for that criterion e.g. for all those registered, enter * in
the Registration # field
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o

To Find Missing information (i.e. empty fields) enter = e.g. all those without emails enter
= in E-mail field

o

For 2 criteria where both are needed e.g. Continuing members who don’t have email,
from the drop-down menu in Status click on (C) and also = in the E-mail field. (note: this
is just an example; all members now should have an email address).

o

For 2 criteria that are different, click on New Request and then either include or omit
the 2nd criterion e.g. Potential members that did not attend Spring Talks, click the
Potential Member field, New Request, click on Attended Spring Talks field then Omit
For both Continuing and New Members, from the drop-down menu in Status click on
(C)and then New Request from the drop-down menu in Status click on (N) and Include
(i.e. a member cannot be both Cont. and New)
For a range of information 3 dots are used between e.g. for those registered in the
month of April, enter 4/1/2015...4/30/2015 in Date Registered field

o

o
o

For before/after or greater than/less than e.g. members before 2015, enter <1/1/2015
in Mbr Since field.

•

To Sort A Find
o Click on Sort, from the list in the left box (alphabetical) choose your criterion e.g. Last
Name, highlight it and Move it to the right box and Sort. (If another search criterion is
already on the right-hand side delete it and highlight the criterion you wish to sort.)

•

To View a Found List
o PRO - Choose a layout to view it e.g. Mbr-Email Only. Do not need to click Preview first
o WEB – Choose a layout e.g. Mbr-Name Email. Click on the View List icon

4. Registration Guidelines
Applicants may register for up to 3 workshops online. Fourth workshops may be requested when there
is space available in a workshop after the closing date for holding places for New Members (typically
after July 1st).
Payment is by a PayPal or credit card/debit card through PayPal.
No receipts will be issued unless requested. NO REFUNDS WILL BE OFFERED AFTER SEPTEMBER 30. Also,
registrants who withdraw after 60 days of registration, will pay a $5.00 Administrative Fee.
Registrations are validated in the database on receipt.
Registrations are received from:
-

Continuing Members - were members in the past year
New Members – have never been members
Rejoining Members - members returning after an absence
Associate Members - have been members in the past and are no longer active but wish to keep
in touch
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NOTE - New or Rejoining members may already be in the database as Potential Members.
New Members - Three spaces in each workshop are reserved for new members until July 1st. After that
any available spaces held for new members will be allocated to those on waitlists in priority sequence.
New registrations are acknowledged by the Volunteer Coordinator with an invitation to complete
Biographical information providing a link to the online form https://allto.ca/tell-us-about-yourselfacademy-member-bio-form/.
The Volunteer Coordinator checks the database weekly for New until September. After that the person
registering any New member must email the Volunteer Co-Ordinator to advise.
WAITLISTS - Workshops with more than the maximum allowed registrants are randomized in early May
to determine the waitlist sequence. (See Section 11 for details). Applicants on waitlists are called or
emailed to determine if they wish to remain on the waitlist or choose another workshop. Registrations
for over-subscribed workshops received after randomization are added to the end of the waitlist. Let
the member know that they have been added to the waitlist and encourage them to select another
workshop. Note in NOTES with initial and date.
If the applicant is the only one above the maximum, ask the facilitators if they are willing to accept one
more. Again note this in NOTES and edit the Maximum in the Workshop Record layout.
POTENTIAL MEMBERS
- Guests attending Spring Talks - Perform a FIND to ensure that the person is not already in the
database. If not, enter as a “New Record.” Check the Potential Member and Spring Talks boxes and
enter a Date in the Potential Date Updated field. Enter only if they have an email address.
DECEASED MEMBER – The ”Deceased” should be checked. Change the Status to W. Delete them from
any workshops that they are registered for. Make a note that the member has passed away.
The President should be notified to send a condolence note to the family.
If classes have not yet started, the family might be asked if they would like the fee returned or donated
to the Academy or a charity of their choice.
CANCELLED WORKSHOPS - A minimum number of applicants (generally eight) is required for a
workshop to proceed – but the number is subject to change on a case-by-case basis and is decided by
the Curriculum Committee in consultation with the facilitator(s) of the workshop in question. The Chair
of Membership and the person currently responsible for registration (*) will be informed by the
Curriculum Committee in early August of cancelled workshops. Applicants will be contacted by the
registration team to be advised that their workshop does not meet the minimum number of participants
and offered assistance in choosing another workshop.
( )

* (by e-mailing registerattheAcademy@gmail.com)

OTHER CONTACTS - i.e. UNIVERSITY, SENIORS, CULTURAL, MEDIA & OUTREACH LISTS - these lists are
for P.R., to recruit, advertise or to keep our partners informed.
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These lists give additional fields for Title and Organization name etc.

5. Checking Payment
●

When reviewing registrations, payment must be checked.

●

Go to the PayPal website www.paypal.com and click log in. Our account name is
membership@allto.ca. The password will be provided individually.

●

Check the list of names and amounts that appear. If the name is not there, or the amount is
insufficient, contact the member to pay and give this direct link so that they can bypass another
registration https://allto.ca/registration-payment/
NOTE: The complete list of payments can be found as follows: On the right hand side of the
screen you will see Transactions. Click on More > and change the dates for the time period you
wish (under Activity). If you can’t find a name, enter it in Search on the right-hand side of the
screen.

●

When facilitators register, the Review User Registration layout will show their payment code
(see table). Facilitators often pay the full amount or more than required. For any amount
different from that in the Amount Paid dropdown box, first enter the amount required, and then
the difference in ‘Other.”
PAYMENT CODE
nil

Sole

Sole facilitator

$90.00

Co

Co-facilitating a workshop

$120.00

Tri

Facilitating a workshop with 3 facilitators

nil Co x 2

Co-facilitating two workshops

●

If a member has overpaid or paid twice, email to let them know and to check whether the
second payment might be for another registration.
Make NOTES on any contact and response.

●

If a refund is required, they are processed in PayPal by the membership committee. If a cheque
is required the Chair will ask the Treasurer to issue refund.
FYI PayPal allows refunds up to 60 days after payment. After 60 days, we charge an
administrative fee of $5.00. After September 30, no refunds are given.
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6. Registration Validation Procedure
6.1. Checklist for Processing a Registration
See more details in the next section (6.2)
Please remember to add notes, detail as to which workshops were selected and always date and initial
those notes.
USING THE ‘REVIEW USER REGISTRATION’ LAYOUT
A. Press ‘Show Records to be reviewed’ in the Registration category. Process new registrations
assigned to you and any Follow Up records within your numbers assigned.
B. Review the new data just entered (on the left) for validity
• email address: xxx@xxxx.xx
• phone: 999-999-9999 (insert dashes)
C. Check User Status and apply changes or create a new record:
• If data does not match, check for hidden/unmatched blanks, punctuation, etc.
• If ‘name only match’ - investigate and manually update in Member Information:
i. investigate (Window → New Window → Member Information → Find)
ii. email person to confirm match, update User Notes, set to Follow-up
iii. if it’s a new registration, press Create/Update Member Information, proceed as ‘if
a match’
iv. if a match, note the Member ID (the number below FIND RECORD FOR on the
Member Information layout). Enter the number on the Member ID field (last field on
the Registration Request side of Review User Registration), proceed to D.
• Otherwise, press ‘Create/Update Member Info’ to apply changes or create the new record
• If ‘…Potential…’ remove both the Potential ‘x’ and the Potential Added date.
D. Fill in the required registration data on the right:
• Status, Amt. Paid: If not Paid – do not continue processing.
• Date Registered: Fill in if no workshops selected; otherwise it is automatic.
• Registration #: Click Registration # to get the next available registration number.
• Member Notes: Include comments, date, initials.
E. Do one of these three to finish processing (if not already done in ‘name only match’ above):
• Process It - press the Blue Button ‘Create registration records’
• Hold it for Follow-Up – select ‘Follow-up required’ from the dropdown in the Action field
• Discard it – select ‘Discard’ from the dropdown in the Action field
F. Press the right arrow (top left) for subsequent records to be reviewed
USING THE MEMBER INFORMATION RECORD to add workshops:
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If there is no Member Information record on file, add one with First, Call and Last Name, email and
consents. (This should normally be entered when the member registers). Need to use the next
Registration # (see Section 6.2).
For the first workshop
• Ensure the member data (‘B’ above) and registration data (‘D’ above) are valid
• Select the workshop requested, add Registered On date and Notes
For subsequent workshops
• Select the workshop(s) requested, add Registered On date for each one
• Check for Overlapping timeslots. If overlap, email, add Notes and mark it Follow up
Go back to Review User Registration and set Action to ‘Processed’.

CHECK FOR OVERLAPPING TIMESLOTS IN A GROUP OF RECORDS
•
•

•

At the end of processing each batch of registrations, go to the Member Information layout and
Find the range of registrations just completed (e.g. registration #102…135)
Press the ‘Scripts’ menu (on menu at top of screen beside ‘Window’), select "Find Members
with WS Overlaps". The database will do this automatically as well now but a double check is
always good.
Do a Find with * in the WARNING message field. Found Set are overlaps to deal with.

6.2. Detailed Steps for Using the ‘Review User Registration’ Layout
A. Select the Review User Registration layout in the Registration category.
B. Press the ‘Show Records to be reviewed’ button at the top right, to see the first Follow Up or New
record to be handled. Press the right arrow (in the oval on the diagram below) to get subsequent
records.
C. Become familiar with this layout. Notice the left side is what the Registrant Requested and the right
side is what we have on file for them (if anything). Also note the ‘>’ to the left of the name. Press
this at any time to see the full Member Information record, if one exists. To do this most efficiently,
first click in the left hand box, otherwise, it will state that the record is being used.
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•

A NOTE on the NOTES: Notes on the right go into the Member Information record. Notes on
the left stay with the Registration Request. If there is no Member record yet on file, make your
notes on the left.

D. Process all New records. Only process Follow Up records that you created.
E. Review the data entered for validity
I.
Check that these mandatory fields are entered and have valid formats:
• email address is xxx@xxxx.xx
• phone number 999-999-9999 (insert dashes if they are missing)
II.
Ensure the remaining mandatory fields (Consent to share etc.) are filled in.
III.
Ensure there are no titles in the name fields e.g. ‘Dr.’, ‘Ms.’. To remove any titles found, go
to the Member Information layout and remove them there.
IV.
Review the remaining data on the left and update as required.
F. Check the User Status and apply changes or create a new record:

i. Check the User Status (bottom left):
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•

•

If ‘Record with name only match found’ (name only match. Here is how to process it: (You
can add a person’s record by taking their Member ID number (if previously registered) from
the Member Record and do a search on the User Registration for this number to call up their
record information You can then proceed to a regular registration process in User
Registration.)
• Find the matched member record by selecting: Window → New Window →
Member Information → Find the name only match.
• If this appears to be an Existing member,
1. Email the person to confirm if this is a match or not
2. Put a note in User Notes while waiting for a reply
3. Set the status to Follow-up to wait for the email reply
• Once confirmed this is a real New member,
1. Press New Record in Member Information to create the member
manually
2. Enter all the Personal information (Name, Phones, email, Emergency
Cont if available)
3. Update the Notes regarding the email mismatch and the resolution
4. Note the Member ID (the number below FIND RECORD FOR on the
Member Information layout). Save the changes.
5. On Review User Registration, enter the number on the Member ID field
(last field on the Registration Request side of Review User Registration).
6. Enter the registration information on the right (Registration #, Status,
Amt Paid)
7. Press the Blue button to process it
▪ Once confirmed that this is an Existing member,
1. Enter the Member ID on the Member ID field on Registration Request.
2. Enter the registration information on the right
3. Press the Blue button to process it
4. Update Notes regarding the email mismatch and the resolution
o NOTE: when a ‘name only match’ is found and a match is found manually. Once the
found Member ID is entered in the Member ID field on the Registration Request
side of Review User Registration, the member data can be accessed.
If ‘…Potential…’ remove both the Potential ‘x’ and the Potential Added date. Process the
same as a "Record found - Potential" after determining which email address is the correct
one.
• Apply changes or create a new record by pressing the Create/Update Member
Information button in Review User Registration layout (if it was not a ‘name only
match’ above).
• If you have accidentally removed one of the mandatory (* on a form) fields, and
receive an ‘Incomplete record’ error message, adjust the data on the left and press the
button again.
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• If you receive an ‘Inconsistent information’ error, this is most likely because more than
one registration request was submitted for a New member, before the Member record
was created on the file
G. Fill in the required data on the right:
1. Status – refer to the system assigned status in the User Status field (bottom left of the
screen) and the Facilitator field. Select the appropriate Status from the dropdown.
2. Amt Paid – check PayPal - to see what / if they have paid
• If paid:
• Check the Status Code and Facilitator field and ensure the amount paid is
appropriate. See the Facilitator Codes and Fees Table (on the following pages).
• Select correct $ amount paid from dropdown.
• If they have paid more than they should, select the correct amount from the
Amt Paid dropdown, key the balance into Other Paid and inquire as to why they
paid the extra and add to Member Notes.
• If not paid:
• Do not register this user yet
• Skip this record and wait a day or so to see if the payment comes through. (Do
not enter registration number or an Action at this time. Enter and initial a User
Note and go on to the next Registration Request)
• If after a day or so, still no payment, contact the potential registrant, update
Member Notes and select Action of Follow-up.
3. Date – ensure this is filled in
4. Registration # (must be unique) – click the Registration # label to obtain the next
available Registration #.
5. Facilitators – if they are marked as a facilitator, check the workshops they have
requested to ensure they have not registered for any of their own workshops.
6. Member Notes - update these with:
• any changes you are making
• which workshops they have requested
• reasons for the Action you are taking on this request
• annotate all Notes with your initials and the date.
H. Choose one of these three to finish handling this record (if not already done in ‘name only match’
above). (Note: the system will ask you to Save the record).
1. Process it - press the ‘Create registration records’ button.
i.
The system then does all of the following automatically for you:
• fills in the Action of ‘Processed’,
• fills in the Registered Date
• creates registration records for all the workshops
• shows these workshop requests in the Member Information record
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•

keeps this record on file but prevents it from showing when the ‘Show records to be
reviewed’ button is pressed
if this member is already registered, pressing this button will display:

ii.

•
•
•
•

Press OK.
Go to the Member Information record (>) and update it manually.
Check how many workshops they have requested in total
NOTE: A member is registered if either of these have occurred:
o A reviewer pressed "Create Registration Record", now or on a previous Review
o A workshop was added directly in the Member Information layout
If you have pressed the ‘Create registration records’ button in error, fix this by going to the
Member Information record (>) and Delete the workshops for this member. Also change the
“Action” appropriately.
Go to the Member Information record
• Press the ‘Workshops’ label to check for overlapping timeslots (or wait and check a
whole group once you are finished)

iii.

iv.

2. Hold it for Follow up:
• select ‘Follow up required’ from the dropdown in the Action field. This keeps the record
on file to appear again next time User Registrations are being reviewed.
• make a note (in the Member Notes) of what you are waiting for that needs to be
followed-up.
• NOTE: Once a record says ‘Follow up required’ as the Action, the person who did the
Follow-up should be the one following up not the next person registering.
3. Discard it:
• select ‘Discard’ from the dropdown in the Action field. This keeps the record on file but
prevents it from showing when the ‘Show Records to be reviewed’ button is pressed.
• make a note (in the User Notes) of what is wrong with it and why you are discarding it.
• ensure all Notes are on the left in the User Notes field (as this is not going onto the
Member Information record)
FACILITATOR CODES and FEES

Facilitator Codes and Fees
Fee

Code
nil

$90.00

Sole
Co

Description
Sole facilitator
Co-facilitating a workshop
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$120.00

Tri

nil

Co x 2

Facilitating a workshop with 3 facilitators
Co-facilitating two workshops

STATUS CODES – Registered Members
Code
Description
C

Continuing (member last year)

N

New

F

Facilitator

A

Associate

R

Rejoining (joined before last year but did not register last year)

W

Withdrawn

L

Life

USER STATUS TABLE - System Generated
User Status – system generated bottom left of Review User Validation screen
(to assist in determining correct Status Code to assign)
New member

(N)

When a record does not exist in the Member table for this user

Associate member

(A)

If the status in the Member record is "(A)"

LIFE member

(L)

If the status in the matching Member record is “(L)”

Registered member

leave
as is

Status is filled in and therefore the member has registered this year
already.

Member last year

(C)

A registered member last year

Member in the past but
not last year

(R)

When "Member since" field is not empty

Record found - Potential

(N) or
(R)

Record in Member table, marked as Potential

(N) or
(R)

Same as “Record found – Potential” but the email does not match.
Process the same as "Record found - Potential" after determining which
email address is the correct one

Potential - name matched
but email different

(Member in the past is checked first, meaning even if the member
record indicates potential, but a date is in the 'member since' field, it is
considered a member in the past)
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Record with name only
match found

(N),
(C) or
(R)

First/Call Name and Last Name match a record already in the Member
Information table. But the email does not match therefore this may or
may not be the same person. Once it is determined whether this is a
new or existing member, the update and registration for this member
must be manually entered directly in the Member Information record,
by looking at the information in Review User Registration.

Member last year – Record
with name only match
found

(N),
(C) or
(R)

Registrant has clicked ‘member last year’ or ‘member in the past’, and
First/Call Name and Last Name match a record already in the Member
Information table. But the email does not match therefore this may or
may not be the same person. This could be because of a mismatched
email (spaces, abbreviations, middle vs first name, initials) or perhaps
they clicked the wrong button. See if you can find a record in Member
Info that is similar to this registration. If found, determine if this is the
same person. If not found, inquire why they did not click ‘new’.

Member last year – Record
not found

(N),
(C) or
(R)

Registrant has clicked ‘member last year’ or ‘member in the past’, but
we cannot find a match for them in the Member Information table. This
could be because of a mismatched email or name (spaces, abbreviations,
middle vs first name, initials) or perhaps they clicked the wrong button.
See if you can find a record in Member Info that is similar to this
registration. If found, determine if this is the same person. If not found,
inquire why they did not click ‘new’.

Record found but status
unclear

(N),
(C) or
(R)

Record found in member table, but it does not match any of the above
criteria. Therefore:
• a match has been found to First/Call Name, Last Name and email
• the following are blank: Status, Member Since, Potential Member.
• they were not a member last year.
Check the Member Info record to see what is wrong. You may have to
contact the member to understand. Once you know, make Notes to
describe what happened and manually input this registration request.
This has most likely occurred because something was done in the
member table outside of normal procedure. e.g. someone created a
potential member record but forgot to check "Potential" member.

NOTES:
There are times when you found the member record for the registrant and cannot see any differences in
the Names or eMail. This is usually due to:
On the first registration page (“User Sign-in”), the registrant entered one of the fields incorrectly. When
they get to the second registration page (User Registration), noticed the error and corrected the entry.
POTENTIAL vs NEW MEMBERS
Potential members are those interested in the Academy but NOT MEMBERS. When Potentials actually
join, they become New (N) or Returning (R) members. This information is still maintained in the
Member Information layout as it was before.
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To find either New or Potential members, go to the Member Information layout:
•
•

To find all the potential members – do a Find with an * in the Potential Member field
To find all the New members – do a Find with an (N) in the Status field

MESSAGES AND EXPLANATIONS
Message: Member registered for workshops already, please review workshops in <Member
information> layout and update list of registered workshops manually
1. This message comes up when you press the "Create registration records" button. It is telling
you the member has registered already, so the system will NOT process the registration records
automatically. Hence the message is telling you to go update the workshop list manually in the
"Member Information" layout
2. After you update the workshop lists for the member, you need to come back to "Review User
Registration", put comments in "Member Notes" and change "Action" to "Processed".
3. After you change "Action" to "Processed", next time you press the "Create registration records"
button, it will tell you the Record has been processed before.
4. If you do not change the "Action" content, the system will always show the same message since
it is still the same condition it detected. It does not go to "Member Information" to check if you
have done the change or not (the system cannot assume what the user wants from the request,
hence cannot determine if what you did is correct or not).

Message: ‘Incomplete record’:
If you have accidentally removed one of the mandatory (*) fields, and receive an ‘Incomplete
record’ error message, adjust the data on the left and press the button again.
Message: ‘Inconsistent information’
If you receive an ‘Inconsistent information’ error, this is most likely because more than one
registration request was submitted for a New member, before the Member record was created on
the Member Information file.
Message: ‘This record cannot be modified in this window because it is already being modified in a
different window’
• You have two windows open for the same record (e.g. Member ID 421 on the Review User
Registration layout and on the Member Information layout). You will get the message if you do
the first update in one window and then try to do an update in the other window.
• Close one window and do your updates in the other. i.e.
EITHER: close the Member Info record and do updates on the Review User Registration
layout,
OR: click on the left side of the Review User Registration layout (which releases the record
from being updated in the system’s view) or change to a different record in the Review User
Registration layout and then do your updates in the Member Info record.
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Message: ‘User Pressed Submit’
• Q: Why does the system show the 'User pressed submit' indication (bottom left), and
why might this be needed?
• A: When a user tries to register but does not finish (i.e., does not press the 'Submit'
button on the final registration screen) the system keeps their info in the Registration
file, marked Discarded, with a 'User pressed submit' indication of 'No'. If you notice a
record in the Registration file that says 'No' to 'User pressed submit', you know that this
was not intended to be an actual registration by the user and should be ignored; only
those that say 'Yes' are to be processed.
USING THE MEMBER INFORMATION RECORD to add workshops
You will need to add workshops directly in the Member information record, if any of these have
occurred:
• The member has already registered this year (a reviewer already pressed "Create Registration
Record" now or on a previous review, or a workshop was added directly in the Member
Information layout)
• There was a partial match for the registration request to a member already on the Member
Information database (e.g. a Name Only Match)
• A new member submitted several registration requests, before they were added to the Member
Information table
• The system assigned ‘Record found but status unclear' status to a registration request
• Someone telephoned or emailed a member of the committee to register “manually” (with
payment already made)

Create a Member Information record – include all mandatory fields
• First Name, Call Name, Last Name, Email and Phone
For the first workshop, in the Member Information record
• Add registration #, status, Amt Paid, Registration Date
• Select the workshop requested along with Registered On date
• Update Notes
For subsequent workshops, in the Member Information record
• Select the additional workshop(s) requested
• Select Registered On date for each
• Update Notes
• If more than one workshop is requested, check for Overlapping timeslots by pressing the
“Workshops” text as follows:
o place your cursor over the word "Workshops" and you will see a little box pop up that
says "Press to see Overlaps" (this is just to remind you what to do)
o press the word "Workshops" and it will check for overlaps and display a bright red
WARNING message if there are conflicts, and will do nothing if there are none
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o

if overlaps have been requested, email the user, make appropriate notes and mark for
Follow Up.
o once you hear back and eliminate the overlaps by adjusting the workshops, press the
word "Workshops" again to remove the red message, update the notes and marked it
Processed
NOTE: pressing "Workshops" only checks the workshops for the current Member record
•

Notify the facilitators of any additions/deletions to their class list.

Go back to Review User Registration and set Action to ‘Processed’

7. Entering Workshops, Facilitators, Tech Support and Membership on the
Database
7.1 Workshops and Facilitators
•
•
•
•

•
•
•
•

Go to the Workshop Record layout.
Work from the list of workshops and descriptions provided by the Curriculum
Committee in the specific order of that list. Edit the format to match the database
i.e. font Arial, size 12, titles in title format and not bold.
Move (The) and (A) in titles to the end of the title in brackets.
For each new entry click on New Record (at the top).
IMPORTANT – any errors in order must be reported to the Database Manager to
correct
Enter the workshop name and all boxes apart from the Room # and Maximum which
will be provided and entered later.
Make sure the # of Facilitators for that workshop is correct. Three facilitators are
the maximum by a Board decision, March 2017.
Copy and paste the workshop description from the list.
Enter the facilitators
- Click on the arrow in the Choose box and scroll down to the last name, first name
of the facilitator of the workshop
- Enter the Payment Code (see table). If the facilitator has already been entered
for another workshop that code will show as either Sole or Co. If it is Sole, leave
that code as nil payment is required. If it is Co, change this code to Cox2 in the
second workshop as this requires nil payment. Leave the original code in the first
workshop. The system will automatically check this.

PAYMENT CODE
nil Sole Sole facilitator
$90.00

Co

Co-facilitating a workshop
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$120.00

Tri

nil Co x 2

-

Facilitating a workshop with 3
facilitators
Co-facilitating two workshops

NOTE: Once a facilitator is added on the Workshop Record, it can be viewed on the Review
User Registration layout and on the Member Information layout – Extended Information
tab.

Updating Facilitators
-

To Change from one facilitator to a different one, go to the existing facilitator row and select
a new name (which will automatically replace the existing one).
To Delete a Facilitator, click on D

7.2 Tech Support
The Membership Information Layout contains a field called ‘Wkshp Tech Supp’ which is used to identify
those members who are able to provide technical support for workshops. The three printed class lists
(‘Class List’, ‘Class List with Consents’, ‘Class List with Phone Consents’) will show this information.
There is a drop own box with two options:
‘TA’ - for active workshop tech support for this year
‘T’ – for those capable as workshop tech support but did not currently commit to any workshop
Display the “Tech Support Potentials by Workshop” list by pressing the “Wkshp Tech Supp” text. This list
includes all potential Workshop Tech Support members for the Tech Support group to identify whom to
assign as workshop tech support for each workshop.

7.3 Membership Committee Assignment (Can change this for next term to include all
Membership Committee tasks and assignments)
To track the assignment of committee members for registration, there is a layout called ‘Membership
Committee Use’ accessible from the ‘Layout’ dropdown menu.
You can add/change the From and To dates for who is responsible for Registration and check those who
have access to the registration email anytime.
To add a new record to this list:
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1. From the "Member Information" layout, find the member you want to add. Note the member
number on the far right side of the highlighted member name (above the tabs).
2. Go to the "Membership Committee Use" layout
o Select "New Record", a new row will show up at the bottom
o Enter the member number you noted in the field (top right corner of the headings)
o Press Enter
To Delete a record, select the row, and select "Delete Record"

8. Cancelling Workshops:
•

The Curriculum Committee confirms cancellation of a workshop.
• (Reference “Cancelled Workshops” instructions under Section 4.)
• Notifies the Membership Committee Chair (directly) and the member currently
processing registrations by e-mailing registerattheAcademy@gmail.com.
• The committee member with access to the registration e-mail will forward messages
pertaining to cancelled workshops to the individual currently processing
registrations for action.

DO NOT DELETE THE WORKSHOP RECORD:
• Select the Workshop Record layout and Find the one you want to cancel
• Change the Workshop Name to bright Red, bold it, strike it through and add ‘(Cancelled)’
after the name, as follows:
• Select the Workshop Name field
• Type in ‘(Cancelled)’ after the name
• Press Format and then Text Colour and select the bright red (5th up from the
bottom, 5th in from the left on the colour chart)
• Press Format and then Style and check off Bold and Strikeout.

•

Notify the Webmaster to label the workshop “Cancelled” on the website workshop listings.

•

Notify the participants in the cancelled workshop and offer assistance in finding an alternative.

•

For each of the notified participants, on the Member Information layout, do the following:
•
•
•

Delete the cancelled workshop by pressing D
If the member elects, register in a selected alternative workshop, if space
available.
Put comments in "Notes" for all changes and initial and date these entries.
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9. Spring Talks
SPRING TALKS GUIDELINES
•

Membership Committee members volunteer at each Spring Talk to record on paper potentials and
attendees who are not Members of the Academy. They enter the information on the database
checking Potential and Spring Talks. If they are not on the database enter them as Potential and
Spring Talks with a date.

•
•

ALL guests are asked to complete the form if they wish to remain on our email list.
They also assist members and new members with registration.

•

IMPORTANT: If they are already on as Potential change the Date Added to the current date so that
they will not be deleted when editing the Potential list. Potentials are removed every two years.

10. Randomization
•

•
•

In April, facilitators of all workshops are contacted by the Curriculum Committee to determine the
maximum they will take in their workshop. The recommendation is no more than 24. However,
some facilitators will go beyond 24 and some prefer fewer. At the end of April or early May,
workshops that are oversubscribed (i.e. above their maximum) are randomized to determine who
will be admitted and who will be waitlisted.
Once the maximum for workshops are determined, they are entered into each workshop record on
the Workshop Record layout.
The Chair invites facilitators of oversubscribed workshops and the Board to attend the
randomization meeting. Any member who wishes to attend, may do so.

The Steps to do Randomization:
1. On Registration ->Randomization Wait List management layout, view the registrations for a specific
workshop
2. In Preview mode, press Ctrl-Shift-C to copy the data
3. Paste into Random.org
4. Press the Randomization button to randomize the list
5. Print/save the randomized list to a .pdf
6. Figure out who goes on the waitlist using: number of registrations, max allowed and New registrations
accepted and on W/L. (Ensure there are 3 NEW in the accepted list, if not, move up priority of other
NEW or allow space for them if less than 3 signed up).
8. In the Waitlist Management layout, add people on the waitlist in sequence shown on the
randomization result.
Details on processing once you have the randomized list:
Assume Randomization of the workshop has occurred and we have a list:
First # to be used on the wl =
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Max allowed in workshop - # new allowed in workshop + # new already randomized in + 1 to start
with next person after max.
Example:
24 max allowed in a workshop, 3 places must be used/held for new members, 30 Total people
requesting this workshop, 1 new randomized in, 1 new randomized onto WL
Using the formula: 24 - 3 + 1 + 1 = 23
So start the waitlist at # 23. Therefore, the class would have 22 people registered and there would be 2
spots (# 23 and #24) for the additional 2 new people who need to be accommodated in this workshop.
Notes:
The 1 new on the waitlist would not be given a waitlist number but would be admitted into the class (as
the 23rd person, since we only had 22 in the class before) leaving one more spot (#24) open for the third
new member when they register.
There will be no randomization after the April/May randomization meeting.
●
●

If people register for an oversubscribed workshop later, a W/L number is entered in the W/L#
field. This number will be the next number in the sequence.
For workshops not oversubscribed after Randomization, but that later end up with a W/L,
priority will be determined by the date of registration and the registration number allocated at
that time.

W/Ls are not provided to facilitators until classes begin. There are many workshop changes and new
registrations over the summer and it is difficult to update facilitators constantly. However facilitators are
always eager to have class lists. Therefore, the following are sent
-

A preliminary list about a week after Confirmation Letters to allow time for changes in choices.
A second about a week after 4th choices are made available
A final just before classes begin along with any W/L.

Adding members to workshops after Randomization until July 1
If a new member withdraws make sure there are 3 NEW before adding a Continuing member.
Randomization Process Explained in One Sheet

Class Distribution list function:
-

The Registration -> Class Distribution List layout is to make creation of class distribution lists of
email addresses easier to send out to facilitators et al.
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-

-

This layout will show email addresses only for any of the classes displayed on one of the class
lists (Class List, Class List Management, Class Attendance Sheet or Randomization Wait list
Management.)
To extract a hyperlinked class list from this layout, go into preview mode and create a .pdf
This layout can be generated in one of two ways:
1) Follow the instructions on the layout to select a workshop and see the Class List (with no
waitlisted people) OR
2) Display the Class List/Management/Attendance list and once it contains the Found Set
of people for whom you would like a distribution list, select the Class Distribution List
layout BUT DON’T PRESS ANY BUTTONS! The email list that you first see when the
layout comes onto your screen, will be for all those showing in the layout you just came
from.

11. Confirmation and Waitlist Procedure
Assigned to Committee Members by Registration Numbers. These are the same numbers as reviewed
for registration (typically up to 50 per person).
a) Call or email re Wait Lists first
b) send Confirmation letters
To go to your Assigned Reg. numbers:
-

Click on FIND, wait for a blank screen, enter your Reg. No. range in the Reg. No. box with 3 dots
between (e.g. 101…150) and return
Click on SORT. Scroll down the list in the left hand box to Registration No., click on Move - it will
appear in the right hand box. Click on SORT
Click on PREVIEW and select layout "Reg No/Name/phone/e-mail"
You may wish to print a list of these to check off your work (reduce the columns to print on 1 page)
or check on a saved copy on your computer.

To Contact re Waiting Lists
-

To find those on Wait Lists easily in your range, enter your range in the Reg. No box and check the
‘On a Waitlist x’ box, press Enter – check these on your list with emails and phone numbers.
Email or Telephone each member who has one or more workshops on a Wait List
You might need to explain the randomization process. If emailing, you may want to have a script
ready of explanations and offer help and a call.
Inform the person that often a place arises but they may wish to choose an alternate workshop
with spaces
Explain where to find those with spaces on our website. Suggestions may help them select another.
If any requests are made to be removed from a W/L delete the entire workshop row on the
Membership Record and add the new workshop that has spaces.
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-

NOTE that the contact has been made, dated and initialed with any response (e.g. deleted
workshop) or follow-up that might be relevant. Check Follow Up box if follow up needed
If there are difficulties reaching a member by phone a detailed message may be left and a follow-up
with an email.

When all those with Wait Lists have been called or emailed, confirmations can proceed.
Confirmations must be done individually by selecting each individual registrant separately AND/OR
the Database Manager can provide a complete list of your confirmation letters for you.

CONFIRMATION LETTER PROCEDURE
On Membership Layout
Click on FIND, wait for a blank screen, and enter the specific Reg. No. to confirm in the Reg. No.
box.
Each individual registrant must be done individually – selecting from your range will print all
confirmations in the found range.
- COPY the email address - DO NOT DELETE IT
• To copy, highlight the address
• on a PC - Ctrl- C or on a Mac - Command- C (On a PC right clicks can be used to copy, paste, cut
etc.)
• To paste - Ctrl-V on a PC or on a Mac - Command-V
• OR highlight and go to Edit and Copy & Paste
Go to Confirmation Letter Layout OR Confirmation Letter for Facilitators if (F)
(These are under
Registration). There is also a Confirmation Letter for Facilitators – Attend None (for Facilitators who not
registered for workshops that they are not facilitating)
-

Click on Preview
Click on Save as pdf – assign title i.e. Reg#xx and Where you want it filed (a new document folder
might be a good idea)
Click on Create email and Save
Will automatically go to email program either inserted into the body or attached

On Email
- Paste in your copied email address into TO whom it should be sent:
- Type Academy Confirmation Attached in Subject
Send - all should be emailed within a few days of Randomization
NOTE – on some emails the letter pastes in the email content, on others it attaches. However, both
should be easy for recipients to see.
NOTE in the Confirmation Email box on the database for each record the date sent and initial it.
After the initial confirmations
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-

Each Committee member registering should email confirmations as additional registrations arrive
If there is a W/L for a selected workshop, first call to advise. If they wish to remain on the waitlist
give them the next waitlist number (but try to encourage selecting a workshop with spaces)
To find the LAST waitlist number, check the Class List Management Layout and assign the next
number

IMPORTANT – For ALL registrations after Confirmations have been sent, the facilitators of workshops
much be advised of the additional participant with the email address.

12. Withdrawals
During W/L calls, a few members may ask to withdraw from the Academy. Let them know that
places often come up over the summer and encourage them to wait and see before acting too
hastily. Try to encourage them to select another workshop with space available.
NOTE: they have until Sept 30 to withdraw and receive a refund. Also note that withdrawals after
60 days carry a $5.00 Administrative Fee.
To deal with a firm withdrawal request:
1.
2.
3.
4.
5.
6.

Change the membership record to reflect the withdrawal - change the status to (W).
Enter the amount to be refunded in Withdr Amt field - it will automatically show up in red.
Email the Chair to request a refund. PayPal allows a refund up to 60 days after payment.
Make a note in the Note Field about the refund/reason if applicable and the date plus your initials.
Notify Communications to remove the name from the Mailing List.
Notify the facilitator.
NOTE – Refunds are only paid up to September 30.
Check the follow-up box if needed and remove when the matter is resolved.

PS. Next Year. Enter the individual as a Potential Member in next year’s database after registration
closes in February. Do not enter them only if they really don’t want to hear from us again which can
happen. Otherwise, click on the Potential Member box and add the date in the Potential Date Updated
field – this will ensure that they receive a mailing next year.

13.Name Badges
PRINTING NAME BADGES
Name badges are provided for 5 special events:
Spring Lunch (March)
Facilitator Forum & Volunteer Lunch (April)
New Member Orientation (September)
Holiday Lunch (Dec)
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Responses are entered in the Events tab on the Member Information layout by name. Check that they
have paid in PayPal as well.
Use labels #5395 2 1/3” x 3 3/8” – 2 across/4down 8/page
Find event attendees (* in the ‘Attending’ specific event box) and sort by last name.
On the Layout Menu (under Lists and Reports) select Mbr. Call Name Status, Preview and save as pdf.
(you need access to the Layout function, request access from database manager).
On the Layout Menu select Labels and Badges for the specific event on “Layout” inserting an appropriate
logo.
To print labels, find attendees, sort by last name, go to Event Badge (or Holiday Lunch Badge or Spring
Lunch Badges) and preview.
Print 1 page to make sure it fits labels
Print as above. It may be better to print one page at a time, so the printer does not jam
Lists of the attendees and their meal choices are sent to the Special Events Committee in pdf format.
They may sometimes wish to have more lists i.e. a separate list of names by meal choice etc. Special
Events typically wants badges and a list of attendees approximately 4 days before the event.
Also they may want new members indicated with a colored dot and guest badges printed (with a
different coloured dot).
Reports for Special Events
To print a report for the Spring Luncheon (for example):
•
•
•
•
•

Do a ‘Find’ for ‘Attend Spring Lunch’ field on the ‘Events’ tab under the ‘Member Information’
layout
This will show how many people have registered
Go to layouts: ‘Lists and Reports’ -> ‘Spring Lunch Attendance’ – only one record will be shown
Click ‘Preview’ to get into preview mode – all records will be shown
Choose ‘Save as Excel’ or ‘Save as PDF’

A. How to Duplicate a Badge and Make a New Badge
At the top left corner of the screen, you click on File --> Manage --> Layouts. A screen will pop up that
show you a list of all the layouts in the database. You then click on one of the Layouts; e.g. Event Badges
(Name...)., It will be highlighted, after that, go to the bottom and click the "Duplicate" button. Now the
one highlighted is the "Event Badges (Name...) Copy".
If you click "Edit", it will let you change the name.
If you click "Open", it will open the layout in Browse mode, at the bottom of the screen, change
"Browse" to "Layout", this is where you can start changing it. You will need to change back to either
"Browse" or "Preview" mode to see how it look.
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B. Doing a New Badge
You need to make sure that any new badge will print 8 to a page. The Body is 2.194. You can see the size
by looking at the Position tab on the Inspector after you click on "Body" (the left bar on your layout).
Body is on the left hand side and it’s hard to see.
To enable the "Inspector", on the top menu bar, select View-->Layout Mode>Inspector (the 5th one
from the bottom).
If you click "Open", it will open the layout in Browse mode, at the bottom of the screen, change
"Browse" to "Layout", this is where you can start changing it. You will need to change back to either
"Browse" or "Preview" mode to see how it looks.

Inspector Layout

14.Class Lists and Attendance Sheets
1. Preliminary class lists are emailed to facilitators 1-2 weeks after confirmations to membership to
allow time for the many changes that occur. These are in excel format to make compiling emails to the
class easier for facilitators.
To prepare a list
• Go to the Registration Menu. There are various class lists and class management lists to chose
from in the database.
Wait lists are not provided to facilitators at this stage.
The person reviewing registrations after this list has been created must email facilitators re ALL persons
registering providing the name, email address and phone number, where consents have been provided.
Give both class Lists; one with consents and one without.
2. After spaces held for new members have been released and 4th places have been offered to the
membership, a 2nd class list in xl format is provided along with a Waitlist Management. This is also under
the Registration Menu.
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3. The week before classes begin, a final Class List is provided in pdf format from the Class List layout
under Registration. Facilitators are encouraged to circulate this to their participants.
They are also provided a Waitlist Management Report so that they can invite those on the W.L to join
when others are absent or drop out. This is not to be circulated to the class.
4. Attendance Sheets are prepared in the same way – click on the heading, select the workshop, press
the ‘FACILITATOR(S)’ text, preview and save as pdf. These may be sent to facilitators or printed and
placed in files when preparing the class boxes.
All communication with facilitators is by the Membership, Chair (or delegated to Committee members)

15. Reports
There are a number of reports available using Filemaker. Many have been mentioned in previous
chapters.
Registration Reports
• Confirmation Letters
• Confirmation Letters for Facilitators
• Class Lists (with and without phone Consents)
• Class Distribution List
• Class Attendance Sheets
• Class List Management
• Class List Report
• Randomization Waitlist Management
• Summary of Registration by Workshop
• Summary of Registration by member
• Total Membership to Date
Labels and Badges
• Holiday Lunch Badges
• Labels for Workshop Files
• Class Name Tag
• Event Badges
• Spring Lunch Badges
Lists and Reports
• Members: Registration Number Name Email
• Members: Name Status Email
• Members: Name Email
• Members: Email only
• Members: Member Biography Request Report
• Name Phone Email for Board list
• Members: Name Label (for Envelopes)
• Other Contacts – Email only
• Summary of where new members heard about academy
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•
•
•
•
•
•
•

Summary of where found set heard about Academy
Workshop Date and Time
Workshop – class size
Facilitators with email by Workshop
Members and Workshops
Holiday Lunch Attendance
Spring Lunch Attendance

Specialty Reports
• Board Members
• Committee Members
History
•
•
•
•

BoardComm History by Term
BoardComm History by Member
Facilitator History by Term
Facilitator History by Member

16. Volunteer Coordinator Job Description
• Attend Membership Committee meetings and accept general Membership Committee
actions
• Request and enter Optional Data from new members
• After AGM, update Board/Committee notes on the ‘Extended Information’ page
• Try to personally meet and learn about attributes of new members
• Attend New Members meeting at the beginning of term 1 and talk to as many new members
as possible to promote volunteering
• Scout for Nominating Committee to fill vacant positions on the Board
• Scout for Committee members as needed
• For the year 2021-22 only, send ‘Request for Optional Data’ to all continuing members and
enter returning data into the ‘Optional Data’ page.

17. Volunteer Coordinator Procedures
a. Requesting Optional Data
Find New Members as they arrive – busiest when registration opens.

For the first new member:
• In the Database, press ‘Find’ on the upper banner strip on the ‘Member Information’ Layout,
choose (N) from the drop down menu of ‘Status’ on the lower half of the page, press ‘Perform
Find’ on the upper banner strip.
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•
•
•

•
•

The upper banner strip will now show how many new members out of total data records there
are (eg 3/657). The lower part of the page will show the information for the first new member.
Copy the email address, open the ‘Compose’ option in your email application and enter the
email of the member.
Copy the Welcome letter body to the body of the email, changing x in the salutation to the first
name of the member and using your name and email at the end. Copy the ‘Welcome to the
Academy’ heading to the Subject line of the email.
Attach the Optional Data Form to the email and send. The Welcome Letter template and the
instructions to download the Optional Data Form are at the end of this section 16.
Enter the date the letter was sent in ‘Welcome Letter sent’ box on the lower half of the
‘Member Information’ layout in the Database

To find the next new member:
• Go to the leftmost icon in the upper banner, showing left facing and right facing arrows, press
the right facing one. The number next to the arrows will change to 2, and the information on the
lower part of the screen will be that for this second new member. Continue as above.
• Before you finish this session, find the last Registration Number entered so far. Press Find, enter
1… in the ‘Registration #’ box and then Perform Find. The upper banner strip will show the
number of people registered this year out of the total data records. Note this number,( eg
141/657).
To find new members since the last time you looked:
• Press Find, choose (N) from the dropdown menu of ‘Status’
• Enter the next Registration Number and three dots in the ‘Registration #’ box (eg 142…) and
press ‘Preform Find’.
For the year 2021-2021 only, after randomization, send the ‘Request for Optional Data’ letter to all
remaining members. (Sample letter is at the end of this section 16.)

b. Receiving Optional Data
Reply to each person thanking them for the data.
Enter the data.
• Press Find, on the ‘Member Information’ layout add their first and last name and press Perform
Find
• Enter the data in the ‘Optional Data I’ & ‘Optional Data II’ tabs, making sure to enter Y that it
was received at the top. This is critical for searches later on.

c. Tracking Optional Data Request Returns
In September open the ‘Mbr-Optional Data Request Report’ layout. This is under the ‘Lists and Reports’
on the layout drop down. Click on File in the top left-hand corner of the screen and then click Print
Setup… and choose Landscape and OK. Click File and then Print. You can now use this printed form to
track those who have not replied to your request.
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Reg #

First Name

Call Name

Last Name

Email

1

William

Bill

Robbins

brob@rogers.com

2

Susan

Sue

Fox

suef@gmail.com

Welcome
sent on
2018-04-20
2018-04-23

Data
Rec’d

Reminder
sent on

Y
2018-09-21

In September each year
• Check the updated Mbr-Optional Data Request Report (above) and send a gentle reminder to all
who did not fill in an Optional Data form (see sample letter below). Note the date the reminder
was sent on the Report.
• Enter any data received on ‘Optional Data I’ and ‘Optional Data II’ tabs making sure to check Y in
the ‘Received’ box
Another way new members who have not returned their Optional Data can be found:
• Press Find and choose “(N)" in the Status dropdown on the "Member Information" layout. A
box ‘New Request’ appears on the upper banner, and the small banner beneath it goes dark
and adds the options for Matching Records
• Click on New Request.
• Go to “Optional Data I” tab, select "Yes" for "Received Optional Data"
• Click ‘Omit’ on dark banner
• Click Perform Find, the upper banner strip will now show how many new members have not
provided their optional data out of total data records there are (eg 3/657). The lower part of
the Member page will show the information for the first new member who has not provided
their optional data.
• Clicking the right-facing arrow in the upper banner strip will move you through the list of new
members who have not provided their optional data.

d. Scouting for Members to Serve as Volunteers
•
•

•
•
•

•
•

Press Find while on the “Optional Data I” tab and enter a checkmark against any skills needed
for the position. Note that for the free-form boxes, you can enter any word you hope is in the
box. Press Perform Find.
The upper banner strip will now show how many members out of total data records there are
with those skills (eg 3/657). The lower part of the Member page will show the information for
the first member with those skills.
Clicking the right-facing arrow in the upper banner strip will move you through the list of
members with those skills.
Review the list for suitable persons.
Ask Facilitators about their suitability. Also ask Facilitators to recommend participants in their
workshops to volunteer.
Provide the list and their telephone numbers to the person who wants the volunteer. There may
be exceptional circumstances when you call the list yourself.
Note any refusals or suggestions in Volunteer Contact on the Extended Information layout.

e. Entering Board and Committee Members in the Database
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•
•
•

•

•
•
•
•
•

After the AGM, open ALLTO website and this year’s database (e.g. all2122db for 2021)
Check with Database Manager to ensure last year’s Board/Committee information are removed
On the website,
a. click Members link on the home page
b. click Board Members
c. Starting with the President, copy the surname
In the Database
a. click ‘Extended Infor’ tab, a grey box at the top of the ‘Member Information’ layout
b. press ‘Find’, paste surname in the name box at the top of the page, press ‘Preform Find’
c. check that both parts of the name now shown are the same as the website, if not
contact Webmaster to discuss
d. enter via the dropdown boxes all Board positions and titles from the website lists
e. in Notes, put last’s year’s position(s) and initial, then delete these from the present
Board/Committee list (press D)
f. save
g. repeat for all on the Board
h. repeat this process for Committee members
i. update records of people on last year’s Board and Committees but not on this year’s,
specifically deleting last year’s positions (press D) and updating Notes.

Check for errors
a. in the Database, go to ‘Speciality Reports’ in Layout (top of the page)
b. print out Board Members and Committee Members lists
c. compare website lists (which are up-to-date) with printouts and note differences

f)
•

Sample letters and Optional Data Form

Letter to new member

WELCOME TO THE ACADEMY
Hello x
I’m delighted to welcome you to the Academy for Lifelong Learning Toronto. We’re so pleased you
joined us!
Soon you will receive a confirmation letter listing your workshops and facilitators. You will then be
hearing from your facilitators suggesting topics for you to choose to research and present. Feel free to
contact them to discuss anything further.
In normal years, pre-pandemic, we have a number of social events as well as our workshops, one of the
great strengths of the Academy. This year is a bit different, but we’ll be creating opportunities to
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socialize and still stay safe. All the upcoming events and opportunities will be on our website so it’s
worth checking it out frequently - https://allto.ca. You will also receive a monthly email update of new
events from the Academy.
As I hope you know, the Academy is a peer-learning group, run by its members with no paid staff. As
guided by our Privacy Policy we require only a minimum of personal data for you to register. But it is
helpful for us to know a little more about you, partly so we can plan workshops and other activities of
interest to all members.
We also hope you may (in the future) choose to join in the running of the Academy; volunteering is a
great way to make new friends. Knowing more about you helps us suggest good fits for volunteer
positions, for example memberships on the Committees or the Board, or getting your feet wet with
facilitating alongside an experienced facilitator. This extra information is entirely optional and it is only
used in aggregate by the Board and individually by the Volunteer Co-ordinator and other members of
the Membership Committee. If you do not register at the Academy for two consecutive years this
information is deleted from our database.
We trust you will feel comfortable sharing this optional data. You can fill in whatever you decide to
share on the attached Word form, save and attach it to an email to me at patcross@londonst.com. You
will have my sincere thanks, as the Academy’s Volunteer Co-ordinator, because it will make my job
much easier.
If you have any questions or comments about the Academy please get in touch with me by return email
or call me at 416-534-8690. I’ll do my best to help. Answers to many questions are also contained in the
Members’ section of the website. The password for the Members’ section of the website is A2021LL.
We all wish you an enjoyable and stimulating experience at the Academy.
Pat Cross, Volunteer Co-ordinator
Membership Committee

•

Letter to Continuing Member for 2021-22 only

Hello X
You may have noticed that registration was slightly different this year, we asked for less information
from you, following our new Privacy Policy. We have asked for optional data in the past and we’d like to
do this again now to cover the data that is not part of the registration process. The reasons we want this
optional data are twofold.
First, we need aggregate data to understand our members, to plan workshops and social events that
meet their needs and wishes.
Second, we would like to know who is willing to volunteer to help run the Academy (it’s a great way to
meet new friends!). Knowing more about you helps us suggest good fits for volunteer positions, for
example memberships on the Committees or the Board, or getting your feet wet with facilitating
alongside an experienced facilitator.
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This extra information that we are asking of you is entirely optional and it is only used in aggregate by
the Board and individually by the Volunteer Coordinator and other members of the Membership
Committee. If you do not register at the Academy for two consecutive years, we will delete the
information.
I hope you will feel comfortable sharing this optional data. You can fill in whatever you decide to share
on the attached Word form, save and attach it to an email to me at patcross@londonst.com. You will
have my sincere thanks, because it will make my job much easier.
Pat Cross, Volunteer Coordinator
Membership Committee

•

Accessing the Optional Data Form

In the database,
• Go to ‘Special Information’ Layout (top of the page)
• Put your mouse inside the box that shows the name of the form and right click
• Left click "Export Field Contents"
• It will ask you where you want to save it. Choose a suitable folder on your computer and click
Save
This form is locked. If you are a new Volunteer Coordinator you will need to change at least the return
email, other changes must first be discussed with the Membership Chair, Assistant Chair and Database
Manager.
To unlock it
• Right click the ribbon in Word, so you have the Developer option
• Click Developer and then Restrict Editing
• Click Stop Protection at the bottom of the pop up panel
To lock it again
• Click Developer and then Restrict Editing
• Under Editing Restrictions, click ‘Filling in forms’ on the drop down box on the second point and
then ‘Allow only this type of editing’
• Click ‘Start enforcing protection’
• Do not enter a password on the pop-up box that appears, just click OK
Send the changed form to the Database Manager

18.Email Communications for Registration
This section contains a number of sample emails that are sent out by the Chair (or delegated) regarding
registration.
Number Date
1
late March

Who
Potentials

What
Registration/spring talks
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2
3
4
5
6

Early April
Early April

Facilitators
Facilitators

Registration starts: Workshop Size
how to register

mid-April

Last year's members who
have not rejoined

Registration

7

late April

Registration Phase 1 closes

8
9

everybody (Communications
email)
Spring Talks
All registered people

end of May
After
Randomization
After
Facilitators
Randomization

Registration
Confirmation letters (by people who processed
registrations)
Initial Class Lists

11

end of May

Last year's members who
have not rejoined

Registration

12
13

June/July
early July

update Membership on changes
4th workshop available

14
15

mid July
late May

Facilitators
everybody (Communications
email)
waitlisted members
Last year's members who
have not rejoined

16
17

Specific cases
Specific cases

PayPal
Gifts from Facilitators

18

Specific cases

Response to Negativity re Randomization Process

19

Specific cases

Request for Fee Adjustment

All registered members

President’s Welcome Letter

New Members Orientation

Do in collaboration with Special Events

10

20
21

Early
September
September

1.

make changes?
Registration

Potentials regarding Spring Talks and Registration

AUDIENCE: Potentials Email List

RELEASE DATE: late March
Create list from FMP database and email this
content individually to each person.
Subject: News From The Academy for Lifelong Learning (University of Toronto)
Salutation: Good Afternoon {First Name here}
I’m sending you this email because you have, in the last two years, shown some interest in the
Academy for Lifelong Learning and/or have attended one of our forums, Spring Talks, walks or some
other event.
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Next xxxxx, April xx we will begin registration for our 20xx-xx Academy workshops. There are over xx
exciting learning opportunities to choose from and if you click on the link below it will show you a
“sneak peek” of our exciting year ahead! (add link)
Additionally, beginning xxx we have an outstanding series of Spring Talks which will take place at Innis
College (2 Sussex Avenue).
Please click on the link below to see a preview of our upcoming line-up. (add link)
If you have any questions about registration or the Spring Talks or you no longer wish to receive these
emails, please let me know.
Thank you for your interest in the Academy for Lifelong Learning.
xxx
Membership Chair
For more than 25 years, the Academy for Lifelong Learning has attracted members who are intellectually
curious, interested in exploring and understanding the world, sharing ideas, and meeting others who share
their interests. Learn More About Us by visiting www.allto.ca.

2. Registration Process for Facilitators
AUDIENCE: Facilitators
Facilitators are NOT counted in workshops if it is
their own. They are counted like any other
member however if they take workshops from
others which may many do. In that case, they are
simply another member. They can take three
initially then add a fourth in July just like any
other member.

RELEASE DATE: before registration
Sent by Membership Chair to all Facilitators

Dear 20xx-xx Facilitators:
Registration will open for all Academy members on xxxx and the following information will assist you
as a Facilitator in registering:
All Facilitators register even if you are NOT taking any other workshops in addition to facilitating your
own workshop and even if you do not pay because you are a SOLE or Co-Facilitator 2X, etc. and are
not taking any workshops. Please note in the Registration “NOTES” that you are a facilitator and not
taking any workshops.
We need your registration information on file to be able to assign you a new registration number for
our files for this year. In addition, we have a Privacy Policy which must be agreed to before everyone
registers.
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If you are a sole facilitator or co-facilitating 2 workshops and wish to take advantage of the free
registration, simply “enter/submit” your choices but you do not have to go through to payment.
For all others, please note your status in the Payments drop-down menu i.e. “co” or “tri” and pay
accordingly.
Note: DO NOT register for workshops that you are facilitating.

3. Randomization for Facilitators
AUDIENCE: FACILITATORS

RELEASE DATE: a week before Randomization

Invitation for all Facilitators to attend
Randomization Process

Dear Facilitators:
Randomization for over-subscribed workshops will take place next week on xxxx at xxx. A
Communications email will go out to all members inviting them to attend if they so wish to see the
process taking place. I would like to extend a special invitation however to all Facilitators to attend
if you can or would like to come. It takes less than an hour.
If you would like to know your individual numbers before Randomization, please email me and I will
send them to you.

4. Non Registered members from last year
AUDIENCE: LAST YEAR’S MEMBERS WHO HAVE
NOT REJOINED

RELEASE DATE: two weeks before
Randomization

Dear Academy Member:
As you know, Registration opened on xxx for our new academic year. You have plenty of time to make
your choices and register before our new year begins in September. If you have registered in the past
week, we thank you!
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However, I would like to let you know that the Membership Committee will be doing Randomization
for oversubscribed workshops on xxx at xxx. You might consider joining before this date if you would
like an equal chance to be randomized into an oversubscribed workshop. After xxx, oversubscribed
workshops will have a wait list only.
We look forward to you rejoining us again now or later as per your choice and we wish you a good
spring and summer.
You can go to registration at the link below:
https://allto.ca/register/
5. End of Phase 1 of Registration
AUDIENCE: Communications email

RELEASE DATE: shortly before Randomization

If you have not registered for the 20xx-xx Workshops please note that Phase I will end at midnight on
xxxx. On xxx Randomization for oversubscribed workshops will take place at xxxx. Any Academy
member wishing to see the process taking place is very welcome to attend this meeting.
6. Spring Talk Attendees re Registration
AUDIENCE: SPRING TALKS
Message from The Academy for Lifelong Learning

RELEASE DATE: End of May

Good Afternoon,
I want to take this opportunity to thank you for supporting The Academy for Lifelong Learning if you
attended our xxx Spring Talks this past April and May. We hope you found them enjoyable and
stimulating.
If you were not able to join us for the Talks, perhaps you might still be thinking of joining the Academy
to attend workshops and our other activities beginning in September 20xx.
The core of the Academy is our xx workshops held from September to March each year. These afford
innumerable learning opportunities on a variety of subjects. We hold three spots open in workshops
for new members until July 1st. You might wish to take a look at some of these and perhaps consider
joining the Academy? We hope you will give this some thought.
Our full workshop list and descriptions can be viewed at https://allto.ca/workshops/ .
The Academy has other activities such as forums held in the fall and winter to which you are invited
and these are free as long as there is space. We have discovery walks throughout the year in different
parts of the city in which you might be interested in as well.
As a member, you will get notifications of all these activities. Otherwise, you can check out all our
events and activities at http://www.allto.ca/ .
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Should you have any questions, please don’t hesitate to contact me at the email address above.
Best Wishes,
Membership Chair

7. Confirmation Letter: see Section 11

8. Class Lists: see Section 14
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11. Last Year’s Members who have not re Joined
AUDIENCE: MEMBERS FROM LAST YEAR WHO
Late May
DID NOT REJOIN
Academy for Lifelong Learning: A Message from the Chair of the Membership Committee

Dear
In preparation for the beginning of our new academic year and fall workshops, I noticed that
you were a member of the Academy last year but have not yet rejoined this year. We hope
that you will be joining us once again this year. You can check out the varied learning
opportunities still available this coming September at the Academy at:
https://allto.ca/workshops/.
If for whatever reason you have decided not to rejoin, be assured that we will miss you and
your participation.
opportunities still available this coming September at the Academy at:
https://allto.ca/workshops/.
If for whatever reason you have decided not to rejoin, be assured that we will miss you and
your participation.
Also, if you have decided not to rejoin us this year, it is our practice to change our database
status for you to what we call Potential Member. In this case, you will hear from us about
two or three times during the coming year via email to let you know about our Forums and
Spring Talks which you may attend without being a member. The forums are free and there
is a small charge for Spring Talks. You can check out our web site as well at any time for
these and other events at: https://allto.ca/.

12.Facilitators regarding Registration Updates
AUDIENCE: FACILITATORS

RELEASE DATE: June/July

Many people are already starting to ask for changes to their workshops, withdrawing or wishing to
add to their roster. Now that most people have heard from their Facilitators, they may have a
tendency to communicate directly with you only and not Membership.
It is critical that Membership be informed of any changes so the numbers for workshops will be as
accurate as possible in the Summary Lists we have. We don’t wish to turn people away from
workshops because the wait lists have not been updated.
Many thanks for keeping this in mind along with the many other responsibilities you all have as
Facilitators.
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You can communicate with either me directly or registerattheAcademy@gmail.com if you have any
changes to your workshops.

13. 4th Workshop Available
AUDIENCE: All Academy Members (by
Communications email)

At end of first week in July

Academicians,
The places held for New members have been released. Therefore, you may now request a 4th
workshop.
A number of interesting learning opportunities are still available, as shown on our website: ACADEMY
WEBSITE. (Note: some workshops are already FULL.)
Please email your selection to Registration@allto.ca as soon as possible and we will process your
request and confirm it with you.
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14. Suggest Waitlisted Members change their workshops
AUDIENCE: WAITLISTED MEMBERS

JULY 13

You are still wait listed for one of the workshops you have chosen and, in a couple of cases, the only
workshop you have chosen. As we are fairly close to the beginning of classes, it is unlikely that any of
these lists will open up, save for the odd spot in the event that some unfortunate person falls ill, etc.
In early September, I will be sending out several types of class lists to facilitators including one which
has a list of their wait listed members. Some facilitators manage their wait lists actively. Others
prefer not to and consider their workshop full and closed.
From time to time the “active manager” facilitators invite wait listed people to join their workshop on
days when they know that someone will be absent but no on a regular or ongoing basis. You may find
this sufficient if you are given this option by a facilitator. If you would like something more permanent
and rewarding for the academic year, I would encourage you to take another workshop from one of
the excellent opportunities still available before workshops begin. See current availability at:
*Put in website link here
Please let me know by return email if you would like to take another workshop.
If not, no need to reply. Your wait list status will not be changed on our database.
Many thanks.
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15. Members who did not rejoin
AUDIENCE: MEMBERS FROM LAST YEAR WHO
May 22, 2018
DID NOT REJOIN
Academy for Lifelong Learning: A Message from the Chair of the Membership Committee

Dear
In preparation for the beginning of our new academic year and fall workshops, I noticed that
you were a member of the Academy last year but have not yet rejoined this year. We hope
that you will be joining us once again this year. You can check out the varied learning
opportunities still available this coming September at the Academy at:
https://allto.ca/workshops/.
If for whatever reason you have decided not to rejoin, be assured that we will miss you and
your participation.
Also, if you have decided not to rejoin us this year, it is our practice to change our database
status for you to what we call Potential Member. In this case, you will hear from us about
two or three times during the coming year via email to let you know about our Forums and
Spring Talks which you may attend without being a member. The forums are free and there
is a small charge for Spring Talks. You can check out our web site as well at any time for
these and other events at: https://allto.ca/.

16. Aversion to PayPal (Additional Responses: If Needed)
AVERSION TO USING PAYPAL
You are only paying using your Credit/Debit Card via PayPal as our “collecting agent” and not through
an account with PayPal. Thus any transaction is verified by your bank and not PayPal itself.
Those who register before xxx are randomized to oversubscribed workshops and all have an equal
chance of getting in. After that, throughout the summer, often space becomes available in many
courses as people switch, change their minds, occasional illness and so on.
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17. Gifts from Facilitators
GIFTS FROM FACILITATORS (SAMPLE RESPONSE)
Background: Some Facilitators give the Academy a “gift” i.e. they pay or give extra money more than
they actually owe. Please remember to post these “extra” payments in Other Paid and not Amount
Paid.
You wrote a note on your Registration that you are willing to submit a nominal fee despite the fact
that you are a Sole Facilitator and receive your membership at no cost. (Facilitator wrote an email as
follows: “I am a sole facilitator but willing to submit a nominal fee. There is no procedure for this.
Please let me know.”) Thank you so much – what a wonderful gesture.
We always welcome “donations” to help the Academy. You can submit a nominal fee by going to
http://www.allto.ca/thankyou2.html and going through to PayPal. There are only standard
“membership” type fees that are available. You might choose the Associate fee of $50 or the CoFacilitator fee of $90. Just send me an email as to what you have done so I can note this on your file in
our database. Some Sole Facilitators have been generous to give the “Co” fee. If this is more than you
have in mind, you can always send a cheque to our Treasurer. If this is your preferred option, please
let me know and I can give you his/her address.
Many thanks for your generosity.
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18.Randomization Process
RESPONSE TO NEGATIVITY RE RANDOMIZATION PROCESS
We have what is called Randomization for oversubscribed workshops for several years now. It is
explained on our website. Randomization gives people an equal chance of getting into a workshop
they want after the first four weeks of registration in case they were away, ill or other reasons.
Randomization takes place in early May.
I certainly hope you get the workshop you request and that you decide to stay as a member. There are
40 wonderful workshops from which you may choose up to four and of course we also have forums,
spring talks and walks.
19.Request for Fee Adjustment
REQUEST FOR FEE ADJUSTMENT
(i.e. Joined in January and only took advantage of partial year workshop(s)
I hope you do decide to rejoin the Academy for this coming year. We would love to have you back.
Unfortunately, our new year begins now and those who joined up to January are registered for the
previous year and not this coming year so we can’t make a financial adjustment. Many of our
members pay the full year (four courses) but only partake for one term since they are away for the
winter or for some other reason. Others take only one or two courses for the full registration fee.
Our courses run from September to March and most are full year courses and not by term. We only
have one fee regardless of what people opt for.

20. Welcome Letter
The President sends out a welcome letter in early September to all registered members. This is typically
done via Communications.

21. New Member Orientation
The Special Events Committee will send individual invitations from the President to new members. The
Membership Committee will provide a list of new members with email addresses.
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